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Using Export Template for GPA Export

How to Export Using Template

Version 2.0 - Updated February 2, 2016

School Power Users can run Export with Template for GPA export using the Export Using Template page in
PowerSchool.

1.

On the Start Page, select Stored Searches.

Start Page

I Students | Staff | Parents | District Students | District Staff]

n (] Advanced View Fiel

ABCDEFGH I
g 10 11 12 M F Al

K. LM NO

Stored Searches

Current Student Selection (0)

El The current selection is empty.

Stored Selections  Multi Select

STUVWIXYZ

2. On the Stored Searches page, select Run Search for the Class of that describes your current Senior

students.

Stored Searches

|Name of Stored Search
2015 in FEB

Class of 2013
Class of 2014
Class of 2015
Class of 2016
Class of 2017

Select Run Search for the
"Class of" that describes
your current Seniors.

al

ol [ o pe

Primary Contact Language is Spanish

y R
TV VNN

Perform Search Now
Run Search

Run Search
Run Search
Run Search

Run Search
> 4 4 4

L g s

Run Search
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3. Onthe Group Functions page, select Export Using Template.
F

Group Functions

Current student selection: 408

Select Students By Hand

Allows for manual selection of a subset of students from currently s|
students.

A A VN VNN W S U P W

Mass Enroll Speciar Program

Lnrolis currently selecied siuderus in'a special piograin.
Re-Enroll in School

Re-enroll students into the current schoal.
Transfer Out Of Schoal

Transfers currently selected students out of school.
Export

I Export Using Template
List Students

Uses a template to exports data on currently selected students.

Prints a quick list of currently selected students.
Quick Export

Exports data on currently selected students.

5. On the Export Using Template page, select Students from the drop down menu.
6. Click Submit.

|
Export Using Template

:Option

Value
Type of Export:

-

I
R
Student Schedules

Teachers

Historical Grades

7. From the Export template? drop down menu, select High School Cumulative GPAs Export.

8. Select the radio button next to the selected student group.
9. Click Submit.

Export Using Template
:0ption Value

Type of Export: Students

Export template?

| High School Cumulative GPAs Export

For Which Records?

]

® The selected 408 students

10. Be patient. This report takes some time to run.
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11. On the Opening student.export.text window, select the Open with radio button, and choose

Notepad (default) from the drop-down menu,

12. Click OK.

You have chosen to open:

] student.export.text

which is: TEXT file

from: https.//powerschool.sandi.net

What should Firefox do with this file?

if not already selected.

Motepad (default)

() SaveFile

[] Do this automatically for files like this from now on.

13. The file will automatically open in Notepad, it may take some time so be patient. To view the
progress of the download, click the download arrow on your computer.

Help

File Edit View History Bookmarks Tools
Export Using Template ®

\ & | @ https://powerschool.sandi.net/admin/importexport/exportusingtemnplate/
s

v | |' Google

[2h Most Visited {_} Getting Started

)

u

2% PowerSchool

student.export.text

Help | Sign Out

nknown time remaining — 17.3 KB

OoI; SEld g Term: 15-16 Year

14. When the student.export page opens, select F
Save the document to your preferred location.

ile and choose Save As... from the drop-down menu.

El
File | [Edit Format VWiew Help
Iew Ctrl+MN he First Name Middle Name Grade Lewvel
Open.. Cirl+ 0 12 2816 2.57 2.57
Cave Chrlat 2816 3.92 3.58 3.90 3.58 3.98
- 4,08 3.67 4,68 3.65 4,08 3.65
| Savehs.. 2016  2.75  2.58 2.91 2.73  2.91
Page Setup.. 4,25 3.92 4.27 3.91 4,27 3.91
oy e 3.48 3.98 3.40 3.50 24 a4 36
3.19 3.84 3.17 3.88 3.17 3.88 3.29
Exit 2.80 2.45 2.808 2.45 2.68 22 64
o T 12 2016 3.88 3.29 3.95
a 12 2816 2.53 2.53 2.62 2.62
. 12 2816
4,08 4 46 4.08 4,29 26 115 38 -
A4.78 4,08 4.78 4,68 4,42 25 116 38 -
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How to Import PowerSchool GPA Exports into Excel

Site Users can take the exported High School Cumulative GPAs text file and import them into Excel. This
will allow the user to rank students and sort them in various ways.

1. Launch Excel and click on the File tab.

& O E -

IMSERT PAGE LAYOUT FORMULAS DATA

ME

| D |Calibri dn R =E=gm e B
Em -
Paste ¢ B I U- EH- O-A- =s==&= B-
Clipboard Font [P Alignment i
Al - ﬁ.
A | B C D E F G
1 |
— L ]
2
3

2. Select Open, click Computer, then select Browse to locate the file.

Book1 - Excel

New
Open @ Recent Workbooks E;I CompUter
Recent Folders
s @ Sites - San Diego Unified Desktop
School District
Save As My Documents
OneDrive - San Diego Unified Deskiop
Saue o dobe & oo District
Print &&, OneDrive
Share Browse
Export E—ig% Other Web Locations
Close Etl Computer
b=
Account
o= AddaPlace

Options

3. Find the location of the saved file and Click on it.

@ v 4 B Desktop

Organize » Mew folder

[ Microsoft Excel

4 ‘l:r‘ Favorites
B Desktop I
[ Downloads
?_9; Recent places
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4. Click on the drop down menu at the bottom right and select All Files.

@ = 4 [ Desktop » v & Search Desktop

Organize * MNew folder g2 ~

)
Microsoft Excel 8| This PC
[l Libraries

3¢ Favorites g Network

B Desktop
-ﬂ Downleads
%5l Recent places

M ThisPC Select All Files from
& Desktop the drop-down menu.
E:I Documents
ﬂ. Downloads

File name: |

Excel Files

5. Click on the Text File called student.export and select Open.

v & Search Desktop y:l

B8~ M @

1% This PC
[ Libraries

?‘; MNetwork ’
Fj student.export 34K TEXTFile |

6. On the Text Import Wizard - Step 1 of 3 pop-up window, make sure that the radio button is
selected for Delimited. Click Next.

The Text Wizard has determined that your data is Delimited.
If this is correct, choose Mext, or choose the data type that best describes your data,
Original data type

e lype that best describes your data:
I Characters such as commas or tabs separate each field.

_ ) Fixed width - Fields are aligned in columns with spaces between each field.

Verify the
Delimited radio
button is selected.

File origin: 437 : OEM United States

HOME10,1001084108876\Desktop\student. export.text.

Ftudent NumberLast NameFirst NameMiddle NameGrade LevelClass Of£f10-1Z2
\1220163.283.283.143.143.143.143_3225823
:1220163.713.713.733.733.733.733.712489
1220162.912 917 682 _68Z_6BZ_68Z._942
1220163.223_223_223_223.053.053.112

Cancel
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7. On the Text Import Wizard — Step 2 of 3 pop-up window, make sure that the box next to Tab is
checked. Click Next.

This screen lets you set the delimiters your data contains. You can see how your text is affected in the
preview below.

Drelimiters

[] Treat consecutive delimiters as one

Text gualifier: |~ W

Verify the Tab
box is checked.

Data preview

lass OFf [10-12 | A
0le .28
0le .71
0le .31
0ls

Middle Name

o
[}
m
=
m
E
m
[

irst Name

tudent Number [Last Name

LRSS ]

FEinish

8. On the Text Import Wizard — Step 3 of 3 pop up window, make sure that the radio button next to
General is selected. Click Finish.

This screen lets you select each column and set the Data Format,

aformat
h

‘General’ converts numeric values to numbers, date values to dates, and
all remaining values to text.

-

Verify the
General button
is selected.

Data preview

annr.:nl Copersl Coperal soeral cnora]

First Name Middle Name [frade Level [Class O
Lz Eola
Lz Eola
Lz Eola
Lz Fola

ast Name

Cancel || < Back
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9. The student data exported from PowerSchool is now imported into Excel as raw data.

r:)

oo e w2

A | B C D E F G H | J S L M N Q P Q R
|Student N_lLast Name First Nami Middle Ne Grade Lev Class Of | 10-12 Totz 10-12 Totz 10-12 WGI 10-12 GPA 10-12 WGI 10-12 GPA 9-12 Total Credits At Grade Poi Credits At Grade Points 9-12
11498035 Abbott | Aunica 12 2016 3.28 3.28 3.14 3.14 3.14 3.14 3.32 25 82 37 123
532444 Adams  Dylon Reece 12 2016 3.71 3.71 3.73 3.73 3.73 3.73 3.71 24 89 38 141
70498260 Agosto  Steven  Joseph 12 2016 291 291 2.68 2.68 2.68 2.68 2.94 23 67 34 100
12798067 Aguirre  Katie Turner 12 2016 3.22 3.22 3.22 3.22 3.05 3.05 311 23 74 35 109
12798199 Aguirre  Samantha Turner 12 2016 2 2 2 2 2 2 1.94 25 50 36/ 70
56865 Alagha | Obada Yaman 12 2016 3.95 3.5 3.95 3.45 3.95 3.45 3.85 22 87 34 131
41398027 Alessio  Sarah Ann 12 2016 4.13 3.79 4.14 3.77 4.14 3.77 4.03 24 99 36 145
426823 Ali Aisha Maseera 12 2016 3.68 3.48 3.65 3.43 3.65 3.43 3.78 25 92 37 140
21398276 Amara  Adam 12 2016 3.96 3.61 3.95 3.53 3.95 3.53 3.69 23 91 35 129
1.21E+08 Andrea | Arianna  Nicole 12 2016 2.57 2.57 2.52 2.52 2.52 252 2.66 23 59 35 93
60993418 Angeles Dannica Caitleen 12 2016 4.04 3.63 4.05 3.59 4.05 3.59 3.89 24 97 36/ 140
40438052 Antunez Victor 12 2016 2.07 2.07 2 2 2 2 219 28 58 37 81
62497416 Arreola  Bruno 12 2016 3.5 3.17 3.45 3.09 3.45 3.09 3.56 24 84 36/ 128
82098046 Arroyo | Ashly 12 2016 2.85 2.63 2.88 2.63 2.88 2.63 2.63 27 77 38 100
555651 Arroyo | Naesha 12 2016 3.74 3.39 3.74 3.29 3.74 3.29 3.76 23 86 37 139
60897034 Arroyo  Noel 12 2016 2.96 2.88 2.86 2.77 2.86 .77 2.97 24 71 35 104
1.02E+08 Avila Ashley 12 2016 3.76 3.52 3.74 3.48 3.74 3.48 3.58 25 94 36/ 129
1.01E+08 Bach Christian IVelasco 12 2016 3.33 3 3.27 2.91 3.27 291 3.36 24 80 36/ 121
90176 Bahul Alexandre Marie 12 2016 3.83 3.33 3.82 3.27 3.82 3.27 3.78 24 92 36 136
12398182 Bakke Alexandrz Catherine 12 2016 3.46 3.38 3.41 3.32 3.41 3.32 3.58 24 83 36/ 129
60597111 Barajas Ca Emily 12 2016 2.61 2.61 248 2.48 243 248 271 23 60 35 95
1.12E+08 Barnard Joshua N 12 2016 3.92 3.58 3.9 3.5 3.9 3.5 3.89 24 94 36/ 140
rrine  |Rnzendn 12 201A 283 283 288 285 288 285 25 24 AR 26 an
student.export ‘ () [

Note: The student data is imported with basic (minimal) formatting. Columns and rows may appear

crowded or illegible.

IMPORTANT! Make sure to save your file.

1.
2.
3.

Select the File tab and click Save As, select where you would like to save your file.

Give your file a name, then select Excel Workbook from the drop-down menu.

Click Save.
xE
@ v 4 I Desktop » v & Search
Organize = Mew folder
Microsoft Excel Mame Size Itemn type Date modified
) 1% This PC
7 Favorites = Libraries
B Desktop € Metwork
1 Downloads
@ Recent places
18 This PC
= Desktop
£] Documents Give your file a name and
4 Downloads select Excel Workbook
; Musie from the drop-down menu.
| Pictures
H Videos v
File name: | Class of 2016 Class Rank
Save as type: | Text (Tab delimited)

= Hide Folders

Excel Workbook
Excel Binary Workbook
Excel 97-2003 Workbook
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Formatting the Data in Excel

The following steps will improve the view of your student data:

1. Select Row 1, to highlight it for changes.
A B C D E F G H

udent N Last Name First NamiMiddle Nz Grade Lev Class Of |10-12 Totz 10-12 Tote
' 12 2016 3.28 3.28
3 | 12 2016 3.71 3.71
4 | 12 2016 2.91 2.91
5 | 12 2016 3.22 3.22
6 | 12 2016 2 2

|

E - Ei D F;; =
HOME = INSERT  PAGE %FORMULAS DATA  REVIEW
D : Calibri -1 -|\ == %- |[E¢WmapTex
@ -
Paste B I U~ &4~ *&v.&v = = | = S EMEI’QE&CEHtEr"
Clipboard = Font Pl Alignment Pl
This will make the text in Row 1, plainly visible.
A B C D E F G H | J K L M
10-12
) ) 1012 | 10-12 | 1012 | 10-12 10-12 9-12
Student Last First Middle Grade GPA
Class Of | Total Total WGPA  GPA w/o GPAw/fo Total
Number  Mame Mame MName Level wio PE,
WGPA | GPA | w/oPE PE PE,ROTC  WGPA
1 ROTC
3. Next, make adjustments to the Column widths to view the student names in their entirety. Click the
top left corner of Excel to highlight the whole worksheet.
4. Then, double Click between the joint of the first two columns in the gray area (between Column A,

and Column B).

~}

4l A = B C D E F G
L[ . . 10-12
Stu@ient Last First Middle Grade 1(
Class Of Total
Number | Name Name Name Level Tots
WGPA
1
2 1.1E+07 Abbott  Aunica 12 2016 3.28
3 532444 Adams Dylon Reece 12 2016 3.71
4 JE+07 Agosto Steven Joseph 12 2016 291
5 1.3E+07 Aguirre | Katie Turner 12 2016 3.22
6 1.3E+07 Aguirre  |Samantha Turner 12 2016 2
PowerSchool
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HINT! Freeze Panes will allow you to “freeze” the column headers so that when you scroll down through
the data, the headers will always be visible.

5. Select Row 2 to highlight it for change, then click the View tab.

6. Click the Freeze Panes icon, and select Freeze Panes from the drop-down menu.

H ©- ¢&- @. 0O F‘i) s texport - Excel
HOME IMNSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT
“:J Ruler Farmula Bar Q [E) :fd I DD E I £ Split [0 View Side by Side ED'_J __E—Lr
£ ' Hide EB1| Synchronous Scrolling
Mormal Page Break Page Custom Gridlines Headings Zoom 100% Zoomto Mew  Arrange Freeze ) . . . Switch Macros
Preview Layout Views Selection  Window Al Panes= | Unhide ' {3 Reset Window Position  windaws - -
Workbook Views Show Zoom Freeze Panes IMacros
. Keep rows and columns visible while the rest of
AZ A j\‘ 11498035 the worksheet scrolls (based on current selection).
Freeze Top Row 1
A B c D E F G Keep the top row visible while scrolling through L
the rest of the worksheet, 10-12 GPA
Student Grade 10-12 Total .
Last Mame First Name Middle Name Class Of Freeze First Column w/oPE,
__| Number Level WGPA Keep the first column visible while scrolling
E= ROTC
through the rest of the worksheet.
2 | J1498035|Abbott |Aunica | | 12| 2m6 3.28| e e e — 3.14
= 532444 Adams Dylon Reece 12 2016 371 371 3.73 3.73 3.73 3.73
4 | 70498260 Agosto Steven Joseph 12 2016 291 291 2.68 2.68 2.68 2.68]
5 | 12798067 Aguirre Katie Turner 12 2016 3.22 3.22 3.22 3.22 3.05 3.05
6 | 12798199 Aguirre Samantha Turner 12 2016 2 2 2 2 2 i
7 56863 Alagha Obada Yaman 12 2016 3.95 3.5 3.95 3.45 3.95 3.45
8 | 41398027 Alessio Sarah Ann 12 2016 4.13 3.79 4.14 377 4.14 3.77
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How to Setup a Class Rank Column in Excel

Site Users can take the exported GPA student data from PowerSchool and create a class ranking in Excel.

IMPORTANT! To correctly Rank the GPA’s of the students selected, the order of the columns must remain
the same. The formula will not work if the order of the columns is moved around or changed.

1. Clickin cell (1,R) and type the words, Class Rank.

H - @ @ 0 F&‘ = student.export - Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT
A 15 =B=9 B & B
T -
Paste B I U By . - === & 5= - - 0 o Conditional Formatas Cell
- o - 4 . § % R Farmatting = Table= Styles~
Clipboard Font m Alignment [ Mumber ] Styles
RL - f Click in cell (1,R)
and type the
] K L [l N R 5
- words, Class S
10-12 GPA 10-12 WGEPA 10-12 GPA 9-12 Total Credits Rank p— —3 Class
wio PE, w/fo PE, Attempted )
wio PE WGPA F ts9-12 | Rank
1 ) ROTC ROTC 10-12 5-12
2 3.14 3.14 3.14 3.32 25 82 37 123
3 3.73 3.73 3.73 3.71 24 89 38 141
4 2.68 2.68 2.68 2.94 23 67 34 100
2. Select Column G, then click Sort & Filter.
L. = s | - 5 oE iy Eolnset -~ 2.1 A
5 e B P PE i
= 5= E - $ - 0 s £ Conditional Formatas Cell — Sort & find &
' Formatting = Table= Styles~ B Format~ €4 Fijer~ Felect -
nt P Mumber Styles Cells Editing
D E F G H I J K L
10-12 WGPA  10-12 GPA
Grade 10-12 Total | 10-12 Total 10-12 WGPA  10-12 GRPA
- Mame Class Of wjo PE, wio PE,
vel WGPA GPA wfo PE wio PE
ROTC ROTC
12 2016 3.28 3.28 3.14 3.14 3.14 3.1
12 2016 3.71 3.71 3.73 3.73 3.73 3.3
12 2016 2.91 2.91 2.68 2.68 2.68 2.]
12 2016 3.22 3.22 3.22 3.22 3.05 3.
3. Select Custom Sort..., from the drop down menu.
:Autu.Sum - A
| oY ik
(] Fill ~ _
X Sort & Find &
[ Clear~ Filter ~ Select -
Editi 2|  Sort Smallest to Largest A
Z] SortLargest to Smallest
Custom Sort...
5 -
Y Filter 3
ade Clal ¥ .-
59-12 Rar o _
I REIPPIY
1
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A Sort Warning message will display. Make sure that the Expand the Selection radio button is
selected.

Click Sort.

Microsoft Excel found data next to your selection, Since you have not
selected this data, it will not be sorted.

What do you want to do?’

O Continue with the current selection

| +ﬂﬂdd Level || nglete Level H EE Copy Level H & | My data has headers

Order

[v] [atoz [v]

Last Mame
First Mame
Middle Name
Grade Level

hlali
10-12 Total WGPA
Wm TULarar~
10-12 WGPA wyo PE
10-12 GPA w/o PE
10-12 WGPA w/o PE, RC
10-12 GP& w/o PE, ROTC ¥

| *a| Add Level H < Delete Level || 2 Copy Level H allw My data has headers

Column Sort On
Sortby  10-12Total WGPA | v | Values

oSO CIS

PowerSchool
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8. Click on the Add Level button four times to open up four additional sorting rows.

+f;_‘l Add Level Oele E@ Copy Level Iz‘ w | Options... My data has headers

Column Sort On Order
Sortby 1012 Total WGPA  [w| |Values [v| |targest to smallest

Then by | | |Ua|ues IE“ |At02
Then by | E“ |Va|ues E| |At02
Then by | E“ |Va|ues E| |AtoZ
Then by | | |Va|ues | |Atoz

9. Under the Column heading, select Last Name from the drop down menu. Make sure that the Order
isAtoZ.

‘ +—ﬂ_&dd Level H 7% Delete Level || E[ Copy Level | Izuz‘ My data has headers

Column Sort On Order

Sort by |1G-12TotaIWGPA E“ |\.ra|ues [v] |Largestto Smaliest [v]

Then by | ast Name w | |values AtoZ w

Then byfl [LastMame ook A v |AtoZ W
FITS0 NdTie |-

Then by |Middle Name [v] [atoz [v]
Grade Lewvel
Then by | cjacc of IE“ |At° Z IE“
10-12 Total WGPA
10-12 Total GPA

1012 WGPA W/ PE | |
10-12 GPA wo PE ok | | cancel |
10-12 WGPA w/o PE, RC &
1012 GPA win PE_ROITC

10. Complete the next three sort orders; First Name, Middle Name, and Student Number.

11. Click OK.

| +—‘1‘l&dd Level H < Delete Level H [ Copy Level |||ZI v My data has headers
Calumn Sort On Order

Sort by ||‘Iﬂ-‘|2TotaIWGPA E“ |Va|ues E" |Largestto Smallest E||
|Last Wame |Va|ues E" |Atoz E"
|First Name [v] [atoz [v]
|Middle Name [v] [atoz [v]
E| |Sma|lestto Largest E”

PowerSchool
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12. This will result in the descending order of Column G, from Largest to Smallest.

“D E}é ) | Calibri =E=_®- B cenen
Pa'ste‘r B I U- s==== - $-%
Clipboard ru Fant P Alignment P Mum
G1 - Jx || 10-12 Total wapa

E F G [ ] K
1 10-12 WGP
Grade 10-12 Total Total 10-12 WGPA & 10-12 GPA
Class Of w/o PE,
Level WGEPA GPA w/o PE wfo PE
1] ROTC
2| 12 206 4.75 4 4.82 4 4.9
3| 12 2016 4.75 4 4.32 a 4.8
4| 12 201§ 4.67 4 4.73 a 4.7
5| 12 2016 4.67 4 4.73 4 4.7
6| 12 2086 4.64 4 4.7 4 4,
7| 12 206 4.63 3.96 4.68 3.95 4.5
8| 12 206 4,59 4 4.64 4 4.4
9 12 2016 4.58 4 4.7 a a,
10l 12 o016 458 4 4,64 a a5

the following formula into the function box above the column headings:

=IF(F2<>F1,1,IF(G2=G1,R1,ROW()-1))

13. To set up the GPA class ranking in Excel, Click within the cell (2,R) to select it. Then, paste or write

H &- & E" O ks student.export - Excel T EH - O X
HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT Stevenson Marina ~ |
& 1 === B Type the foll formula here:
D B 1 A == =5 General ype the fo owmg ormula nere:
By ~ _
T S P e =IF(F2<>F1,1,IF(G2=G1,R1,ROW(-1)) e
- - o ' lect ~
Clipboard @ Font Alignment Mumber Styles Cells Editing I
CONCATE.. | i | X« jl =IF{F2<=F1,1,IF(G2=G1,R1,ROW(}-1)] -] Vv
F G H | 1 K L M M o] P Q R -
10-12 WGPA | 10-12 GPA red i
10-12 Total | 10-12 Total | 10-12 WGPA | 10-12 GPA 9-12 Total Grade Class
Class Of w/o PE, w/o PE, em )
WGPA GPA w/oPE wfoPE WGPA Points9-12 | Rank
1 ROTC ROTC 10-12
2 2016 4.75 a a.82 a 4.82 a 45 16| wi)-1))
3 2016 A4.75 4 4.82 4 4.82 4 4.5 - 162
4 2016 A4.67 4 4.73 4 4.73 4 4.44 24 112 36 160
5 2016 4.67 4 A4.73 4 4.73 4 4.44 24 112 36 160
] 2016 4.64 4 4.7 4 4.7 4 4,42 25 116 38 168
7 2016 4.63 3.96 4.68 3.95 4.68 3.95 4.42 24 111 36 159
8 2016 4.59 4 4.64 4 4.64 4 4.4 27 124 40 176
g 2016 A4.58 4 4.7 4 4.7 4 4,39 24 110 36 158
10 2016 A4.58 4 4.64 4 4.64 4 4.36 24 110 36 157
11 2016 A58 A A.64 4 4.64 A 4,39 24 110 36 158
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14. Click on any cell away from cell (2,R), to apply the formula. The number one (1) will appear,
indicating that the formula is working.

NOTE! The cell (2,R), has a one (1) in it because the formula has ranked this row as the highest WGPA in the

group.
F G i ! J Kessnanbssnsudlony, _N.- o P Q R 5
= 1f S wepa 10-126PA Credits " " "% m g, . Credits
10-12 Total = 10-12 Total 10-12 V\gﬁih 'ﬁ-‘lz GPA 9-12 Total Grade "Mm g Grade Class
Class Of w/o PE, w/o PE, Attempted ArfemhBrea ,
WEPA GPA 40 /0 e wi/o PE WGPA Points 10-12 Poingsg-12 | Rank
1 ROTC ROTC 10-12 9-12 iy
2| 2016 482 4 45 24 114 26 162 ]
3| 2016 2 482 4 45 24 114 36 162 ;
4| 2018 4.67 ) - 4.73 4 a.44 36
5| 2016 4.67 Highest WGPA in 473 4 2.4 Click on any cell e
6 2016 4,64 the group Is 4,7 4 4,42 away from cell '
7| 2006 4.63  ranked number 1. 4.68 3.95 4.42 {2,R) to apply the
5| 2016 4.59 a.54 4 4.4 formula
o | 2016 458 a 47 4 a7 4 .39 26 158
10| 2018 458 a 464 4 a54 4 436 26 157
11| 2018 458 a 464 4 454 4 439 24 110 36 158
1 2015 A58 A A54 A A5 A A.29 24 110 36, 152

15. To apply this formula to the remaining rows. Click on cell (2, R) and double-click on the lower right
corner of the cell (your cursor will change to a plus (+) sign.

0 p Q | R | s
Credit
Grade redis Grade Class
) Attempted i
Points 10-12 9-12 Points 9-12 Rank
24 114 36 152| 1_|
24 114 36 162 \
24 112 35 160
= e Click in the cell (2,R) and
25 116 )
iy i double-click on the lower

right corner of the cell.

16. Column R, will then display the ranking order of the WGPAs for grades 10-12.

F €] H | j) I L Il N 0 P Q - B - S
! 10-12 WGPA  10-12 GPA Credits Credits
10-12Total  @0-12 Total 10-12 WGPA 10-12 GPA 9-12 Total Grade Grade Class
Class O wio PE, w/o PE, Attempted : Attempted )
WGPA GPA wio PE w/o PE WGPA Points 10-12 Points 9-13 Rank

1 | ROTC ROTC 10-12 912 I
2 | 201 475 1 4 4.82 4 4.82 4 4.5 24 114 36 16] 1y
3 201 475 | 4 4.82 4 4.82 4 4.5 24 114 36 1y
4 201 A4.67 4 4,73 4 4.7 4 4,44 24 112 3 3

i “IIIIIIIIIIIIIIIIIIIII|IIIIIqlIIIIIIIIIIIIIIIIIIIIIIIIII !
5 201 4.67 | a 4.73 al 4.44 24 36 31
6 | 201 4.64 | 4 4.7 4 4.7 4 4,42 25 116 38 sl
7 | 201 4.63 | 3.96 4.68 3.95 4.68 3.95 4.42 24 111 36 6|1
8 | 201 439 | 4 4.64 4 4.64 4 4.4 27 124 40 7
9 | 201 458 | 4 4.7 4 4.7 4 4.39 24 110 36 =N
10_ 201 4.38 | 4 4.64 4 4.64 4 4,36 24 110 36 8l
11 | 201 438 | 4 4.64 4 4.64 4 4.39 24 110 36 8l
12 201 4.58 | 4 4.64 4 4.64 4 4,39 24 110 36 E N
13_ 201 438 | 4 4.64 4 4.64 4 4,39 24 110 36 N
14_ 201 456§ 4 4.61 4 4.61 4 4.37 25 114 38 i
15_ 201 456§ 3.92 4.61 3.91 4.61 3.91 4,42 25 114 38 B
15 200 T E=T=4 ASO ac ASo ac F. T~ 24 100 I 2L

NOTE! For students with identical GPAs, the Class Rank will be identical for each of those students.
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17. Right click the heading of Column R, and select Copy from the drop down menu.

Right click
the heading ? .
of Column R. ¥
Class
s10-12 =P Points 9-12 | Rank
9-12 g6 Cut

114 36 162
114 36 162 Paste Options:
112 36 1 e, e

=4 =
112 36 160 &t 1=
116 38 168 Paste Special...
111 36 159 Insert...
124 40 176 Delete...
110 36 158 Clear C
110 15 15?— ear Contents
110 36 158 & Quick Analysis
110 36 158 Filter
110 36 158 Sort
114 38 166 | c
114 ag 168— [ Insert Comment
109 35 157 Eormat Cells...
109 36 155 Pick From Drop-down List...
103 36 157 Define Mame...
118 38 166

R '% Hyperlink...

109 36 157 | I

18. Right click the heading of Column S, and select Paste Options: 123, from the clipboard.

Right click the

o | heading of = S 1
1 1
Grade Column &. | :
bints 10-12 | | Rank |
1 1
114| 36| 162| U ¥ cut
I
I
114| 36/ 162] L gy copy
112 36| 160! al o :
i i— Uy Paste Options:
113 36| 160! 3 —~ e o
116| 3a| 168! 51 Ao lgE B
111 36| 159 6! =] ,
! . -
124' 4ﬂ| 176, ?= Insert Copied Cells
110 36| 158! 8
llﬂ'l 36| 15?= 8: Delete
llﬂl 35| 153} gi Clear Coptents
1
110| 36/ 158l 8l Format Cells..
110| 36| 158] Si Column Width...
114 38| 166! 13 ,
1 I Hide
114| 38| 168| 131
109 | 36/ 1571 15! Unhide
109 36| 1551 15! |
109)| 36 157t 15 | |

PowerSchool

How to Run Export with Templatee Page 15



&
3

<

San Diego Unified

SCHOOL DISTRICT

19. This will create a class ranking order in Column S, identical to the class ranking in Column R.

NOTE: The pasting option of 123, into Column S (used above), transferred the numerical value of Column R,
only, and not the formula. This means that no matter which column is used to sort the data, the class rank
in Column S will remain accurate.

Because Column S
contains the numerical value
of Column R, only, and not

the formula, the class rank
will remain accurate no
matter which column is used

to sort the data.

W] M (8] P Q I R I S T
Credits Credits
9-12 Total Grade Grade Class Class
Attempted i Attempted )
WGPA Points 10-12 Points 9-12 Rank Rank
10-12 9-12

1 4.5 24 114 36 162 1
1] 4.5 24 114 36 162 1
1] 4.44 24 112 36 160 3
1] 4.44 24 112 36 160 3
L 4.47 25 116 38 168 5
1] 4.47 24 111 36 159 6
L 4.4 27 124 40 176 7
L 4.39 24 110 36 158 )
L 4.36 24 110 36 157 )
L 4.39 24 110 36 158 )

0O 0O 0D wl LN W e e

NOTICE! When the data is sorted by a different column, Column R is no longer accurate, but Column S
maintains the proper ranking.

D E F G H P Q RGO s &

L 4 o &

10-12 | 10-12 ’ wedits | Grads ‘%Q' g}”
A Grade Class i las ass
Middle Mame Total Total W tempted  Point
Level Of Rank Rank
WGPA | GPA il +12 g-12

12| 2016 3.88 346 ' 1 101

= 2 222

NOTICE! When the data is sorted 3 312

by a different column, Column R, 4 30

is no longer accurate. Column S 5| 238

maintains the correct rankin L o 150

saunae Hitomi g 1 6 180
aseera I 2010 .08 = 1: B 135
ackenzie 12| 2016 3.81  3.65 1 g 114
David 12| 2016 371 338 ' 1 10 127
icholas 12| 2016 3.21 ' 1 11 200
erry 12| 2016 346 .04 1 12 164
leazar 12| 2016 258 258 ' 1 13 298
vier 12| 2016 2.35 2.35 35 14 330
12| 2016 296 2.67 ' a6 1 15 235

11 2016 162 162 4 33 16 391

IMPORTANT! The class rank in Column S will remain accurate regardless of sorting done in any other
column. Column R can be deleted.
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20. To delete Column R, right click the heading of Column R and select Delete from the drop-down
menu.

Right click the

heading of = s T u

Column R. X Cut

e

Class ||Eg C
empte oints & Lopy

9.12 9.12 Rank ‘-D Paste Options:
-
O
36 134 U Paste Special...
a8 116 2
36 99 3 ncert

35 129 4 Delete
36 102 Clear Contents

i s & Format Cells...
37 118 &

37 140 3 Column Width...
38 142 9 Hide

36 133 10 Unhide

42 135 11 200

36 127 12| 16

43 110] 13 298

35 87 14| 320

36 116 15 235

33 61 16| 391

40 176 17 7

36 8 18 255

21. Column S will move over and become the new Column R.

N 0 P a R~ |
Credits Grade Credits Grade :
ttempted Points | Attempted Points Class Column S will
Rank move over and
10-12 10-12 5-12 3-12
become the new
24 93 36 134 101 ColumnR.
28 86 38 116 222
24 G0 36 93 312
23 51 35 129 50
24 70 36 102] 238
25 84 37 119 180
25 84 37 118 180
25 92 37 140) 135
26 99 38 142] 114
24 B89 36 133 127
28 950 42 135 200
24 83 36 127] 164
31 80 43 110) 298
23 54 35 87 330
24 71 36 116 235
21 34 33 61 391
27 124 40 176 7
23 51 36 B84 355

22. Now the student data in Excel can be sorted by any column and the Class Rank data will remain
accurate in Column R.

23. IMPORTANT! Remember to save the document.
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